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Bauble è un programma per la gestione di collezioni di oggetti botanici. Con Bauble puoi
creare una base dati di registri di piante, con molte opzioni di ricerca.

Bauble è software aperto e libero ed è distribuito secondo la GPL: Licenza Pubblica GNU
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CAPITOLO 1

not-so-brief list of highlights, meant to whet your appetite.

1.1 taxonomic information

When you first start Bauble, and connect to a database, Bauble will initialize the database
not only with all tables it needs to run, but it will also populate the taxon tables for ranks
family and genus, using the data from the “RBG Kew’s Family and Genera list from Vascular
Plant Families and Genera compiled by R. K. Brummitt and published by the Royal Botanic
Gardens, Kew in 1992”. In 2015 we have reviewed the data regarding the Orchidaceae, using
“Tropicos, botanical information system at the Missouri Botanical Garden - www.tropicos.org”
as a source.

1.2 importing data

Bauble will let you import any data you put in an intermediate json format. What you import
will complete what you already have in the database. If you need help, you can ask some
Bauble professional to help you transform your data into Bauble’s intermediate json format.

1.3 synonyms

Bauble will allow you define synonyms for species, genera, families. Also this information can
be represented in its intermediate json format and be imported in an existing Bauble database.
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1.4 scientific responsible

Bauble implements the concept of “accession”, intermediate between physical plant (or a group
thereof) and abstract taxon. Each accession can associate the same plants to different taxa, if
two taxonomists do not agree on the identification: each taxonomist can have their say and do
not need overwrite each other’s work. All verifications can be found back in the database, with
timestamp and signature.

1.5 helps off-line identification

Bauble allows you associate pictures to physical plants, this can help recognize the plant in case
a sticker is lost, or help taxonomic identification if a taxonomist is not available at all times.

1.6 exports and reports

Bauble will let you export a report in whatever textual format you need. It uses a powerful tem-
plating engine named “mako”, which will allow you export the data in a selection to whatever
format you need. Once installed, a couple of examples are available in the mako subdirectory.

1.7 annotate your info

You can associate notes to plants, accessions, species, . . . . Notes can be categorized and used
in searches or reports.

1.8 garden or herbarium

Management of plant locations.

1.9 database history

All changes in the database is stored in the database, as history log. All changes are “signed”
and time-stamped. Bauble makes it easy to retrieve the list of all changes in the last working
day or week, or in any specific period in the past.

4 Capitolo 1. not-so-brief list of highlights, meant to whet your appetite.



Bauble Documentation, Release 1.0.50

1.10 simple and powerful search

Bauble allows you search the database using simple keywords, e.g.: the name of the location
or a genus name, or you can write more complex queries, which do not reach the complexity
of SQL but allow you a decent level of detail localizing your data.

1.11 database agnostic

Bauble is not a database management system, so it does not reinvent the wheel. It works
storing its data in a SQL database, and it will connect to any database management system
which accepts a SQLAlchemy connector. This means any reasonably modern database system
and includes MySQL, PostgreSQL, Oracle. It can also work with sqlite, which, for single user
purposes is quite sufficient and efficient. If you connect Bauble to a real database system, you
can consider making the database part of a LAMP system (Linux-Apache-MySQL-Php) and
include your live data on your institution web site.

1.12 language agnostic

The program was born in English and all its technical and user documentation is still only in that
language, but the program itself has been translated and can be used in various other languages,
including Spanish (86%), Portuguese (100%), French (42%), to name some Southern American
languages, as well as Swedish (100%) and Czech (100%).

1.13 platform agnostic

Installing Bauble on Windows is an easy and linear process, it will not take longer than 10
minutes. Bauble was born on Linux and installing it on ubuntu, fedora or debian is also rather
simple. It has been recently successfully tested on MacOSX 10.9.

1.14 easily updated

The installation process will produce an updatable installation, where updating it will take less
than one minute. Depending on the amount of feedback we receive, we will produce updates
every few days or once in a while.

1.15 unit tested

Bauble is continuously and extensively unit tested, something that makes regression of func-
tionality close to impossible. Every update is automatically quality checked, on the Travis
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Continuous Integration service. Integration of TravisCI with the github platform will make it
difficult for us to release anything which has a single failing unit test.

Most changes and additions we make, come with some extra unit test, which defines the
behaviour and will make any undesired change easily visible.

1.16 customizable/extensible

Bauble is extensible through plugins and can be customized to suit the needs of the institution.
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CAPITOLO 2

Istallare Bauble

2.1 Installazione

bauble.classic è un programma multipiattaforma e funziona su macchine unix (Linux e
MacOSX) ma anche su Windows.

To install Bauble first requires that you install its dependencies that cannot be installed auto-
matically. These include virtualenvwrapper, PyGTK and pip. Python and GTK+, you probably
already have. As long as you have these packages installed then Bauble should be able to install
the rest of its dependencies by itself.

Nota: Seguendo le seguenti istruzioni di installazione si ottiene un Bauble installato in un
ambiente Python virtuale, tutte le dipendenze saranno installate localmente e non entreranno in
conflitto con altri programmi Python che possono essere sullo stesso elaborator.

se dovessi in seguito decidere di rimuovere Bauble, basterà rimuovere l’ambiente virtuale, che
è una directory, con tutto il suo contenuto.

2.1.1 Installare su Linux

1. Scaricare il programmino devinstall.sh ed eseguirlo:

https://raw.githubusercontent.com/Bauble/bauble.classic/master/
→˓scripts/devinstall.sh

Nota bene: il programmino di cui sopra non installerà alcun connettore a base dati.
Questo è lasciato per un passo successivo.
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A titolo d’informazione, il programmino esegue i seguenti passi: installa le dipendenze
che non possono essere soddisfatte in un ambiente virtuale, crea poi l’ambiente virtuale,
di nome bacl (che sta per ba(uble.)cl(assic)), scarica i sorgenti e connette il checkout
git alla linea di produzione bauble-1.0, dopo di che procede con la sua installazione,
che implica lo scaricare tutte le dipendenze. Questo può prender tempo. Infine crea un
programmino di avvio di nome bauble, nella directory ~/bin dell’utente corrente.

Se il programmino di installazione termina senza errori, si può ora avviare bauble:

~/bin/bauble

o aggiornare bauble all’ultima versione rilasciata nella linea di produzione:

~/bin/bauble -u

Lo stesso programmino puoi utilizzarlo per cambiare ad un’altra linea di produzione,
anche se al momento c’è solo la bauble-1.0.

2. su Uniti, apri un terminale, avvia bauble, la sua icona (un diamante verde) apparirà nel
launcher, e se si vuole lo si può saldare al launcher.

3. If you would like to use the default SQLite database or you don’t know what this means
then you can skip this step. If you would like to use a database backend other than the
default SQLite backend then you will also need to install a database connector.

Se si desidera utilizzare un database PostgreSQL, si attivi l’ambiente virtuale e si installi
psycopg2 con i seguenti comandi:

source ~/.virtualenvs/bacl/bin/activate
pip install -U psycopg2

Potrebbe essere necessario risolvere delle dipendenze. Come farlo, dipende dalla
distribuzione Linux che si sta utilizzando. Consultare la documentazione corrispondente.

Next. . .

Connettersi ad una base dati.

2.1.2 Installare su MacOSX

Considerando che MacOSX è unix, la maggior parte dei passi sono uguali al caso Linux,
diciamo così.

Una difficoltà importante su MacOSX è che ci sono davvero moltissime versioni diverse di
questo sistema operativo e non ci è possibile sostenerle tutte, inoltre Apple «l’impresa» tiene
aggiornate solo le ultime due versioni, così che su quelle precedente potrebbe essere difficile o
impossibile installare software recente.
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Last time we tested, some of the dependencies could not be installed on MacOSX 10.5 and we
assume similar problems would present themselves on older OSX versions. Bauble has been
successfully tested with 10.7 and 10.9.

Prima di tutto, è necessario completare quello che è un normale ambiente di sviluppo unix, che
non è presente in un mac così come esce dal negozio.

1. attrezzi di sviluppo: xcode. verificare sulla wikipedia quale versione è adatta al mac in
questione.

2. gestore di pacchetti: homebrew (su versioni più vecchie esiste tigerbrew).

avendo installato le precedenti, eseguire:

brew doctor

assicurati di aver capito il messaggio di errore, in modo da poter correggere la situazione.
pygtk ha bisogno di xquartz e brew non è in grado di risolvere questa dipendenza. per installare
xquartz puoi utilizzare brew, o quello che preferisci:

brew install Caskroom/cask/xquartz

ed ora installare le ultime dipendenze:

brew install git
brew install pygtk # takes time and installs all dependencies

seguire le istruzioni su come attivare quanto installato.

il resto segue come su una normale macchina unix, puoi utilizzare lo stesso devinstall.sh. Leggi
le istruzioni per Linux, seguile, buon utilizzo.

Next. . .

Connettersi ad una base dati.

2.1.3 Installare su Windows

The Windows installer used to be a «batteries-included» installer, installing everything needed
to run Bauble. The current maintainer of bauble.classic cannot run Windows applications. If
you want to run the latest version of bauble on Windows: download and install the dependencies
and then install Bauble from the source package.

Please report any trouble and help with packaging will be very welcome.

Nota: Bauble è stato provato con successo su WXP, W7 e W8. Molto probabilmente funziona
anche su altre versioni, ma non è stato provato.
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Nota: Direct download links are given for all needed components. They have been tested
in September 2015, but things change with time. If any of the direct download links stops
working, please ring the bell, so we can update the information here.

i passi per l’installazione su Windows:

1. scaricare ad installare git (viene con un paio di cose buone come sh e vi), prendendolo
da:

https://git-scm.com/download/win

Direct link to download git

quasi tutte le opzioni per difetto stanno bene: c’è bisogno di specificare che si vuol
eseguire git dalla linea di comando Windows.

2. scaricare ed installare

http://www.python.org

Direct link to download Python

Bauble has been developed and tested using Python 2.x. It will definitely not run on
Python 3.x. If you are interested in helping port to Python 3.x, please contact the Bauble
maintainers.

durante l’installazione di Python, includere Python nel PATH:
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3. scaricare pygtk dalla fonte seguente. (richiede python a 32bit). Fare attenzione a
scaricare la versione «all in one»:

http://ftp.gnome.org/pub/GNOME/binaries/win32/pygtk/

Direct link to download PyGTK

fare una installazione completa, includendo assolutamente tutto:
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4. (opzionale) scaricare ed installare connettori database al lato di sqlite3, presente per
difetto.

Su Windows, NON è facile installare psycopg2 dai suoi sorgenti utilizzando pip, per
piacere evitar problemi ed utilizzare un pacchetto precompilato da:

http://initd.org/psycopg/docs/install.html

Direct link to download psycopg2

5. REINIZIALIZZARE

Giovani, questo è Windows, c’è bisogno di reinizializzare il sistema perché i
cambiamenti abbiano effetto!

6. scaricare ed eseguire il programmino batch:

https://raw.githubusercontent.com/Bauble/bauble.classic/master/
→˓scripts/devinstall.bat

this will pull the bauble.classic repository on github to your home directory, un-
der Local\github\Bauble, checkout the bauble-1.0 production line, create a
virtual environment and install bauble into it.

puoi anche eseguire devinstall.bat passandogli la parte numerica della linea di
produzione che si vuol seguire.

7. scaricare il programmino batch, per restare aggiornati con la linea di produzione scelta:

https://raw.githubusercontent.com/Bauble/bauble.classic/master/
→˓scripts/bauble-update.bat
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if you are on a recent Bauble installation, each time you start the program, Bauble will
check on the development site and alert you of any newer bauble release within your
chosen production line.

in ogni momento che si voglia aggiornare l’installazione, basterà aprire la finestra con la
linea di comando ed eseguire bauble-update.bat

8. you can now start bauble using the bauble.lnk shortcut that the installation procedure
copies to the Scripts directory of the virtual environment:

%HOMEDRIVE%%HOMEPATH%\.virtualenv\bacl\Scripts\bauble.lnk

If you would like to generate and print PDF reports using Bauble’s default report generator then
you will need to download and install Apache FOP. After extracting the FOP archive you will
need to include the directory you extracted to in your PATH.

Next. . .

Connettersi ad una base dati.

2.1.4 Problemi durante l’installazione

1. What are the packages that are installed by Bauble:

I seguenti pacchetti sono richiesti da Bauble

• SQLAlchemy

• lxml

I seguienti pacchetti sono opzionali:

• Mako - required by the template based report generator

• gdata - required by the Picasa photos InfoBox

2. Couldn’t install lxml.

The lxml packages have to be compile with a C compiler. If you don’t have a Make sure
the libxml and libxsl packages are installed. Installing the Cython packages. On Linux
you will have to install the gcc package. On Windows there should be a precompiled
version available at http://pypi.python.org/pypi/lxml/2.1.1

3. Couldn’t install gdata.

For some reason the Google’s gdata package lists itself in the Python Package Index but
doesn’t work properly with the easy_install command. You can download the latest gdata
package from:

http://code.google.com/p/gdata-python-client/downloads/list

Unzip it and run python setup.py installw in the folder you unzip it to.
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Next. . .

Connettersi ad una base dati.
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CAPITOLO 3

Utilizzare Bauble

3.1 Incominciamo

3.1.1 E se fosse SQLite?

Prima di cominciare, domandiamoci tre cose: è la prima volta che uso Bauble?, lavorerò su una
sola macchina?, non ho intenzione di sporcarmi le mani con la gestione di basi dati? Bene, se
abbiamo risposto affermativamente ad almeno una delle precedenti, mi sà che sarebbe meglio
restare con SQLite. SQLite è un sistema SQL rapido, semplice, senza amministrazione.

Con SQLite non c’è bisogno di preparare altro e si può proseguire con connecting.

On the other hand, if you want to connect more than one bauble workstation to the same data-
base, or if you want to make your data available for other clients, as could be a web server in
a LAMP setting, you should consider keeping your database in a database management system
like PostgreSQL or MySQL/MariaDB, both supported by Bauble.

When connecting to a database server as one of the above, you have to manually create: at least
one bauble user, the database you want bauble to use, and to give at lest one bauble user full
permissions on its database. When this is done, Bauble will be able to proceed, creating the
tables and importing the default data set. The process is database-dependent and it falls beyond
the scope of this manual.

If you already got the chills or sick at your stomach, no need to worry, just stick with SQLite,
you do not miss on features nor performance.

3.1.2 Connettersi ad una base dati

All’avviare Bauble, la prima cosa che appare è la finestra per la scelta della connessione.
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Abbastanza naturalmente, la prima volta che si avvia Bauble non ci saranno connessioni a
disposizione. Bauble mostra una finestra di avviso.

Come dice lo stesso testo: chiudere la finestra di avviso, Bauble tornerà alla finestra di
connessione, dove selezioneremo Add per creare la prima connessione.

Semplicemente: inserire un nome per la connessione, una cose semplice e significativa che
si associ naturalmente alla collezione che si vuol inserire (che so, «alberi monumentali»),
e scegliere OK. Bauble torna allo schermo precedente, ma il nome della connessione sarà
selezionato e la sezione Dettagli della Connessione sarà visibile.
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specificare i dettagli della connessione

If you do not know what to do here, Bauble will help you stay safe. Activate the Use default
locations check box and create your first connection by clicking on Connect.

You may safely skip the remainder of this section for the time being and continue reading to
the following section.

fine-tune the connection details

By default Bauble uses the file-based SQLite database. During the installation process you
had the choice (and you still have after installation), to add database connectors other than the
default SQLite.

In this example, Bauble can connect to SQLite, PostgreSQL and MySQL, but no connector is
available for Oracle or MS SQL Server.

3.1. Incominciamo 17
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If you use SQLite, all you really need specify is the connection name. If you let Bauble use the
default filename then Bauble creates a database file with the same name as the connection and .
db extension, and a pictures folder with the same name and no extension, both in ~/.bauble
on Linux/MacOSX or in AppData\Roaming\Bauble on Windows.

Still with SQLite, you might have received or downloaded a bauble database, and you want to
connect to it. In this case you do not let Bauble use the default filename, but you browse in
your computer to the location where you saved the Bauble SQLite database file.

If you use a different database connector, the dialog box will look different and it will offer you
the option to fine tune all parameters needed to connect to the database of your choice.

If you are connecting to an existing database you can continue to Inserire e modificare dati and
subsequently Searching in Bauble, otherwise read on to the following section on initializing a
database for Bauble.

If you plan to associate pictures to plants, specify also the pictures root folder. The meaning of
this is explained in further detail at Fotografie in Inserire e modificare dati.
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3.1.3 Inizializzare la base dati

La prima volta che si apre una connessione ad una base dati che Bauble non ha mai utilizzato
prima, Bauble mostrerà l’avviso:

seguito a ruota da una domanda:

Be careful when manually specifying the connection parameters: the values you have entered
may refer to an existing database, not intended for use with Bauble. By letting Bauble initialize
a database, the database will be emptied and all of its content be lost.

If you are sure you want to create a database at this connection then select «Yes». Bauble will
then start creating the database tables and importing the default data. This can take a minute or
two so while all of the default data is imported into the database so be patient.

Una volta creata, configurata, inizializzata la base dati, siamo pronti per iniziare a editing-and-
inserting-data‘ed in seguito :ref:‘searching-in-bauble.

3.2 Searching in Bauble

Searching allows you to view, browse and create reports from your data. You can perform
searches by either entering the queries in the main search entry or by using the Query Builder
to create the queries for you. The results of Bauble searches are listed in the main window.

3.2. Searching in Bauble 19
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3.2.1 Search Strategies

Three are three types of search strategies available in Bauble. Considering the search stragety
types available in Bauble, sorted in increasing complexity: you can search by value, expression
or query.

Searching by query, the most complex and powerful, is assisted by the Query Builder, described
below.

All searches are case insensitive so searching for Maxillaria and maxillaria will return the same
results.

Search by Value

Search by value is the simplest way to search. You just type in a string and see what matches.
Which fields/columns are search for your string depends on how the different plugins are con-
figured. For example, by default the PlantPlugin search the family name, the genus name, the
species and infraspecific species names, vernacular names and geography. So if you want to
search in the notes field of any of these types then searching by value is not the search you’re
looking for.

Examples of searching by value would be: Maxillaria, Acanth, 2008.1234, 2003.2.1

Search string are separated by spaces. For example if you enter the search string Block 10
then Bauble will search for the strings Block and 10 and return all the results that match either
of these strings. If you want to search for Block 10 as a while string then you should quote the
string like "Block 10".

Search by Expression

Searching with expression gives you a little more control over what you are searching for. It
can narrow the search down to a specific domain. Expression consist of a domain, an operator
and a value. For example the search: gen=Maxillaria would return all the genera that
match the name Maxillaria. In this case the domain is gen, the operator is = and the value is
Maxillaria.

The search string gen like max% would return all the genera whose names start with
«Max». In this case the domain again is gen, the operator is like, which allows for «fuzzy»
searching and the value is max%. The percent sign is used as a wild card so if you search for
max% then it search for all value that start with max. If you search for %max it searches for all
values that end in max. The string %max%a would search for all value that contain max and
end in a.

For more information about the different search domain and their short-hand aliases, see search-
domains .

If expression are invalid they are usually used as search by value searchs. For example the
search string gen= will execute a search by value for the string gen and the search string gen
like will search for the string gen and the string like.
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Search by Query

Queries allow the most control over searching. With queries you can search across relations,
specific columns and join search using boolean operators like AND and OR.

An example of a query would be:

plant where accession.species.genus.family=Fabaceae and location.
→˓site="Block 10"

This query would return all the plants whose family are Fabaceae and are located in Block 10.

Searching with queries usually requires some knowledge of the Bauble internals and database
table layouts.

A couple of useful examples:

• Which locations are in use:

location where plants.id!=0

• Which genera are associated to at least one accession:

genus where species.accession.id!=0

Domains

The following are the common search domain and the columns they search by default. The
default columns are used when searching by value and expression. The queries do not use the
default columns.

Domains family, fam: Search bauble.plugins.plants.Family

genus, gen: Search bauble.plugins.plants.Genus

species, sp: Search bauble.plugins.plants.Species

geography: Search bauble.plugins.plants.Geography

acc: Search bauble.plugins.garden.Accession

plant: Search bauble.plugins.garden.Plant

location, loc: Search bauble.plugins.garden.Location

3.2.2 The Query Builder

The Query Builder helps you build complex search queries through a point and click interface.
To open the Query Builder click the to the left of the search entry or select Tools→Query
Builder from the menu.

3.2. Searching in Bauble 21
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The Query Builder composes a query that will be understood by the Query Search Strategy
described above. You can use the Query Builder to get a feeling of correct queries before you
start typing them by hand, something that you might prefer if you are a fast typer.

After opening the Query Builder you must select a search domain. The search domain will
determine the type of data that is returned and the properties that you can search.

The search domain is similar to a table in the database and the properties would be the columns
on the table. Often the table/domain and properties/columns are the same but not always.

Once a search domain is selected you can then select a property of the domain to compare
values to. The search operator can then be changed for how you want to make the search
comparison. Finally you must enter a value to compare to the search property.

If the search property you have selected can only have specific values then a list of possible
values will be provided for you to choose from.
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If multiple search properties are necessary then clicking on the plus sign will add more
search properties. Select And/Or next to the property name choose how the properties will
be combined in the search query.

When you are done building your query click OK to perform the search.

3.3 Inserire e modificare dati

The main way that we add or change information in Bauble is by using the editors. Each
basic type of data has its own editor. For example there is a Family editor, a Genus editor, an
Accession editor, etc.

To create a new record click on the Insert menu on the menubar and then select the type of
record your would like to create. This will open a new blank editor for the type.

To edit an existing record in the database right click on an item in the search results and select
Edit from the popup menu. This will open an editor that will allow you to change the values on
the record that you selected.

Most types also have children which you can add by right clicking on the parent and selecting
«Add ???. . . » on the context menu. For example, a Family has Genus children: you can add a
Genus to a Family by right clicking on a Family and selecting «Add genus».

3.3.1 Note

Quasi tutti gli editori in Bauble hanno una vista Note, che dovrebbe funzionare ugualmente per
qualsivoglia editore attivato.

Un indirizzo web inserito a sé stante in una nota, viene trattato in modo speciale da Bau-
ble: quando l’oggetto è selezionato nel pannello risultati, l’indirizzo web verrà mostrato nel
contenitore *Links».

You can browse the notes for an item in the database using the Notes box at the bottom of the
screen. The Notes box will be desensitized if the selected item does not have any notes.

3.3.2 Famiglia

L’editore per le famiglie permette aggiungere o cambiare una famiglia botanica.

The Family field on the editor will change the name of the family. The Family field is required.

The Qualifier field will change the family qualifier. The value can either be sensu lato, sensu
stricto or nothing.

Synonyms allow you to add other families that are synonyms with the family you are currently
editing. To add a new synonyms type in a family name in the entry. You must select a family
name from the list of completions. Once you have selcted a family name that you want to add
as a synonym click on the Add button next to the synonym list and it will add the selected
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synonym to the list. To remove a synonym select the synonym from the list and click on the
Remove button.

Per annullare le modifiche, fare click sul pulsante Cancel/Annulla.

Per memorizzare le modifiche effettuate, fare click su OK.

Per memorizzare le modifiche e per aggiungere un genere alla famiglia aggiunta o modificata,
fare click su Add Genera.

To add another family when you are finished editing the current one click on the Next button
on the bottom. This will save the current family and open a new blank family editor.

3.3.3 Genere

The Genus editor allows you to add or change a botanical genus.

The Family field on the genus editor allows you to choose the family for the genus. When you
begin type a family name it will show a list of families to choose from. The family name must
already exist in the database before you can set it as the family for the genus.

Il campo Epiteto permette di specificare l’epiteto di questo genere.

Il campo Autore permette di specificare il nome o l’abbreviazione dell’autore o gli autori della
pubblicazione del genere.

Synonyms allow you to add other genera that are synonyms with the genus you are currently
editing. To add a new synonyms type in a genus name in the entry. You must select a genus
name from the list of completions. Once you have selcted a genus name that you want to add
as a synonym click on the Add button next to the synonym list and it will add the selected
synonym to the list. To remove a synonym select the synonym from the list and click on the
Remove button.

Per annullare le modifiche, fare click sul pulsante Cancel/Annulla.

To save the genus you are working on then click OK.

To save the genus you are working on and add a species to it then click on the Add Species
button.

To add another genus when you are finished editing the current one click on the Next button on
the bottom. This will save the current genus and open a new blank genus editor.

3.3.4 Specie / Tassone

For historical reasons called a species, but by this we mean a taxon at rank species or lower.
It represents a unique name in the database. The species editor will allow you to construct the
name as well as associate metadata with the taxon such as its distribution, synonyms and other
information.

The Infraspecific parts in the species editor will allow you to specify the taxon further than at
species rank.
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Per annullare le modifiche, fare click sul pulsante Cancel/Annulla.

To save the species you are working on then click OK.

To save the species you are working on and add an accession to it then click on the Add
Accession button.

To add another species when you are finished editing the current one click on the Next button
on the bottom. This will save the current species and open a new blank species editor.

3.3.5 Accessioni

The Accession editor allows us to add an accession to a species. In Bauble an accession repre-
sents a group of plants or clones. The accession would refer maybe a group of seed or cuttings
from a species. A plant would be an individual from that accesssion, i.e. a specific plant in a
specific location.

Fonti di Accessioni

The source of the accessions lets you add more information about where this accession came
from. At the moment the type of the source can be either a Collection or a Donation.

Collezione

Una collezione.

Donazione

Una donazione.

3.3.6 Pianta

Editore per le piante.

Creare più di una pianta

È possibile creare più di una pianta in una sola volta, specificando un intervallo come codice di
pianta. Questa opzione è disponibile solo al momento di inserire una nuova pianta, non quando
se ne sta modificando una già presente nella base dati.

For example the range, 3-5 will create plant with code 3,4,5. The range 1,4-7,25 will create
plants with codes 1,4,5,6,7,25.

When you enter the range in the plant code entry the entry will turn blue to indicate that you
are now creating multiple plants. Any fields that are set while in this mode will be copied to all
the plants that are created.
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Fotografie

Just as almost all objects in the Bauble database can have Notes associated to them, Plants can
have Pictures: next to the tab for Notes, the Plants editor contains an extra tab called «Pictures».
You can associate as many pictures as you might need to a plant.

When you associate a picture to a plant, the file is copied in the pictures folder, and a miniature
(500x500) is generated and copied in the thumbnails folder inside of the pictures folder.

As of Bauble-1.0.41, Pictures are not kept in the database. To ensure pictures are available
on all terminals where you have installed and configured Bauble, you can use a file sharing
service like Copy or Dropbox. The personal choice of the writer of this document is to use
Copy, because it offers much more space and because of its «Fair Storage» policy.

Remember that you have configured the pictures root folder when you specified the details of
your database connection. Again, you should make sure that the pictures root folder is shared
with your file sharing service of choice.

When a Plant in the current selection is highlighted, its pictures are displayed in the pictures
pane, the pane left of the information pane. When an accession in the selection is highlighted,
any picture associated to the plants in the highlighted accession are displayed in the pictures
pane.

3.3.7 Locations

The Location editor

danger zone

The location editor contains an initially hidden section named danger zone. The widgets contai-
ned in this section allow the user to merge the current location into a different location, letting
the user correct spelling mistakes or implement policy changes.

3.4 Tagging

Tagging is an easy way to give context to an object or create a collection of object that you
want to recall later. For example if you want to collect a bunch of plants that you later want
to create a report from you can tag them with the string «for that report i was thinking about».
You can then select «for that report i was thinking about» from the tags menu to show you all
the objects you tagged.

Tagging can be done two ways. By selecting one or more items in the search results and pres-
sing Ctrl-T or by selecting Tag→Tag Selection from the menu. If you have selected multiple
items then only that tags that are common to all the selected items will have a check next to it.
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3.5 Generating reports

3.5.1 Using the Mako Report Formatter

The Mako report formatter uses the Mako template language for generating reports. More
information about Mako and its language can be found at makotemplates.org.

The Mako templating system should already be installed on your computer if Bauble is
installed.

Creating reports with Mako is similar in the way that you would create a web page from a
template. It is much simpler than the XSL Formatter(see below) and should be relatively easy
to create template for anyone with a little but of programming experience.

The template generator will use the same file extension as the template which should indicate
the type of output the template with create. For example, to generate an HTML page from
your template you should name the template something like report.html. If the template will
generate a comma seperated value file you should name the template report.csv.

The template will receive a variable called values which will contain the list of values in the
current search.

The type of each value in values will be the same as the search domain used in the search query.
For more information on search domains see Domains.

If the query does not have a search domain then the values could all be of a different type and
the Mako template should prepared to handle them.

3.5.2 Using the XSL Report Formatter

The XSL report formatter requires an XSL to PDF renderer to convert the data to a PDF file.
Apache FOP is is a free and open-source XSL->PDF renderer and is recommended.

If using Linux, Apache FOP should be installable using your package manager. On
Debian/Ubuntu it is installable as fop in Synaptic or using the following command:

apt-get install fop

Installing Apache FOP on Windows

You have two options for installing FOP on Windows. The easiest way is to download the
prebuilt ApacheFOP-0.95-1-setup.exe installer.

Alternatively you can download the archive. After extracting the archive you must add the
directory you extracted the archive to to your PATH environment variable.
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3.6 Importare ed esportare dati

Although Bauble can be extended through plugins to support alternate import and export
formats, by default it can only import and export comma seperated values files or CSV.

There is some support for exporting to the Access for Biological Collections Data it is limited.

There is also limited support for exporting to an XML format that more or less reflects exactly
the tables and row of the database.

Exporting ABCD and XML will not be covered here.

Avvertimento: Importing files will most likely destroy any data you have in the database
so make sure you have backed up your data.

3.6.1 Importing from CSV

In general it is best to only import CSV files into Bauble that were previously exported from
Bauble. It is possible to import any CSV file but that is more advanced that this doc will cover.

To import CSV files into Bauble select Tools→Export→Comma Seperated Values from the
menu.

After clicking OK on the dialog that ask if you are sure you know what you’re doing a file
chooser will open. In the file chooser select the files you want to import.

3.6.2 Exporting to CSV

To export the Bauble data to CSV select Tools→Export→Comma Seperated Values from the
menu.

This tool will ask you to select a directory to export the CSV data. All of the tables in Bauble
will be exported to files in the format tablename.txt where tablename is the name of the table
where the data was exported from.

3.6.3 Importare da JSON

This is the way to import data into an existing database, without destroying previous content.
A typical example of this functionality would be importing your digital collection into a fresh,
just initialized Bauble database. Converting a database into bauble json interchange format is
beyond the scope of this manual, please contact one of the authors if you need any further help.

Utilizzando il formato di scambio JSON, è possibile esportare dati da una versione di Bauble
ed importarli in una versione differente.
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3.6.4 Esportare verso JSON

Questo è ancora “lavori in corso”.

when you activate this export tool, you are given the choice to specify what to export. You can
use the current selection to limit the span of the export, or you can start at the complete content
of a domain, to be chosen among Species, Accession, Plant.

Exporting Species will only export the complete taxonomic information in your database. Ac-
cession will export all your accessions plus all the taxonomic information it refers to: unreferred
to taxa will not be exported. Plant will export all living plants (some accession might not be
included), all referred to locations and taxa.

3.7 Managing Users

Nota: The Bauble users plugin is only available on PostgreSQL based databases.

The Bauble User’s Plugin will allow you to create and manage the permissions of users for
your Bauble database.
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3.7.1 Creating Users

To create a new user. . .

3.7.2 Permissions

Bauble allows read, write and execute permissions.
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CAPITOLO 4

Amministrazione

4.1 Amministrazione

Nel caso si stia utilizzando un vero e proprio DBMS (sistema di gestione di basi di dati) per
contenere le collezioni di Bauble, è importante prendere in considerazione l’amministrazione di
questo DBMS. Una descrizione del compito di amministrare una base dati è qui assolutamente
fuori luogo, ma è importante che un utente sia consapevole del problema.

4.1.1 SQLite

SQLite offre una soluzione in quanto SQLite non è esattamente quanto si potrebbe definire un
DMBS: ogni base dati SQLite è un file, farne copia di emergenza (backup) sarà sufficiente. Se
si è creata la connessione alla base dati SQLite accettando i valori per difetto, il file relativo
alla connessione si trova nella directory ~/.bauble/ (con Windows bisognerà trovare la
AppData).

4.1.2 MySQL

Prego riferirsi alla documentazione ufficiale.

4.1.3 PostgreSQL

Prego riferirsi alla documentazione ufficiale. Una discussione molto approfondita sulle varie
opzioni di backup inizia al chapter_24.
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CAPITOLO 5

Sviluppo di Bauble

5.1 Downloading the source

The Bauble source can be downloaded from our source repository on github.

If you want a particular version of Bauble, we release and maintain versions into branches.
you should git checkout the branch corresponding to the version of your choice. Branch
names for Bauble versions are of the form bauble-x.y, where x.y can be 1.0, for example.
Our workflow is to commit to the master development branch or to a patch branch and to
include the commits into a release branch when ready.

To check out the most recent code from the source repository you will need to install the Git
version control system. Git is incuded in all reasonable Linux distributions and can be installed
on all current operating systems.

Once you have installed Git you can checkout the latest Bauble code with the following
command:

git clone https://github.com/Bauble/bauble.classic.git

For more information about other available code branches go to bauble.classic on github.

5.2 Developer’s Manual

5.2.1 helping bauble development

Installing Bauble always includes downloading the sources, connected to the github repository.
This is so because in our eyes, every user is always potentially also a developer.
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If you want to contribute to Bauble, you can do so in quite a few different ways:

* use the software, note the things you don't like, open issue for
→˓each of them. a developer will react.

* if you have an idea of what you miss in the software but can't
→˓quite
formalize it into separate issues, you could consider hiring a
professional. this is the best way to make sure that something

→˓happens
quickly on Bauble. do make sure the developer opens issues and

→˓publishes
their contribution on github.

* translate! any help with translations will be welcome, so please
→˓do! you
can do this without installing anything on your computer, just

→˓using the
on-line translation service offered by http://hosted.weblate.org/

* fork the respository, choose an issue, solve it, open a pull
→˓request. see
the `bug solving workflow`_ below.

5.2.2 bug solving workflow

normal development workflow

• while using the software, you notice a problem, or you get an idea of something that
could be better, you think about it good enough in order to have a very clear idea of what
it really is, that you noticed. you open an issue and describe the problem. someone might
react with hints.

• you open the issues site and choose one you want to tackle.

• assign the issue to yourself, this way you are informing the world that you have the
intention to work at it. someone might react with hints.

• optionally fork the repository in your account and preferably create a branch, clearly
associated to the issue.

• write unit tests and commit them to your branch (do not commit failing unit tests to the
master branch).

• write more unit tests (ideally, the tests form the complete description of the feature you
are adding or correcting).

• make sure the feature you are adding or correcting is really completely described by the
unit tests you wrote.

• make sure your unit tests are atomic, that is, that you test variations on changes along
one single variable. do not give complex input to unit tests or tests that do not fit on one
screen (25 lines of code).

• write the code that makes your tests succeed.
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• update the i18n files (run ./scripts/i18n.sh).

• whenever possible, translate the new strings you put in code or glade files.

• commit your changes.

• push to github.

• open a pull request.

publishing to production

• open the pull request page using as base the production line, compared to master.

• make sure a bump commit is included in the differences.

• it should be possible to automatically merge the branches.

• create the new pull request, call it as “publish to the production line”.

• you possibly need wait for travis-ci to perform the checks.

• merge the changes.

• tell the world about it: on facebook, the google group, linkedin, . . .

closing step

• review this workflow. consider this as a guideline, to yourself and to your colleagues.
please help make it better and matching the practice.

5.2.3 structure of user interface

the user interface is built according to the Model-View-Presenter architectural pattern. The
view is described in a glade file and is totally dumb, you do not subclass it because it imple-
ments no behaviour and because its appearance is, as said, described elsewhere, including the
association signal-callbacks. The model simply follows the sqlalchemy practices.

You will subclass the presenter in order to:

• define widget_to_field_map, the association from name of view object to name of
model attribute,

• override view_accept_buttons, the list of widget names which, if activated by the
user, mean that the view should be closed,

• define all needed callbacks,

The presenter should not know of the internal structure of the view, instead, it should use
the view api to set and query the values inserted by the user. The base class for the presen-
ter, GenericEditorPresenter defined in bauble.editor, implements many generic
callbacks.

Model and Presenter can be unit tested, not the View.
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The Tag plugin is a good minimal example, even if the TagItemGUI falls outside this
description. Other plugins do not respect the description.

We use the same architectural pattern for non-database interaction, by setting the presenter also
as model. We do this, for example, for the JSON export dialog box.

5.2.4 building (on Windows)

Building a python program is a bit of a contraddiction. You don’t normally build nor compile
a python program, you run it in its (virtual) environment, and python will process the modules
loaded and produce faster-loading compiled python files. You can, however, produce a Windo-
ws executable from a python script, executable containing the whole python environment and
dependencies.

1. Follow all steps needed to set up a working Bauble environment from Installazione, but
skip the final install step.

2. instead of installing Bauble, you produce a Windows executable. This is achieved with
the py2exe target, which is only available on Windows systems:

python setup.py py2exe

3. At this point you can run Bauble. To run the compiled executable run:

.\dist\bauble.exe

or copy the executable to wherever you think appropriate.

4. To optionally build an NSIS installer package you must install NSIS from
nsis.sourceforge.net. After installing NSIS right click on .\scripts\build.nsi
in Explorer and select Compile NSIS Script.

5.3 Extending Bauble with Plugins

Nearly everything about Bauble is extensible through plugins. Plugins can create tables, define
custom searchs, add menu items, create custom commands and more.

To create a new plugin you must extend the bauble.pluginmgr.Plugin class.

5.4 API Documentation

5.4.1 bauble

5.4.2 bauble.db

bauble.db.Base
All tables/mappers in Bauble which use the SQLAlchemy declarative plugin for
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declaring tables and mappers should derive from this class.

An instance of sqlalchemy.ext.declarative.Base

bauble.db.metadata
The default metadata for all Bauble tables.

An instance of sqlalchemy.schema.MetaData

5.4.3 bauble.connmgr

5.4.4 bauble.editor

5.4.5 bauble.i18n

5.4.6 bauble.ui

5.4.7 bauble.meta

5.4.8 bauble.paths

5.4.9 bauble.pluginmgr

5.4.10 bauble.prefs

5.4.11 bauble.task

5.4.12 bauble.types

5.4.13 bauble.utils

5.4.14 bauble.view

class bauble.view.SearchView.ViewMeta
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5.4.15 bauble.search

5.4.16 bauble.plugins.plants

5.4.17 bauble.plugins.garden

5.4.18 bauble.plugins.abcd

5.4.19 bauble.plugins.imex

5.4.20 bauble.plugins.report

5.4.21 bauble.plugins.report.xsl

5.4.22 bauble.plugins.report.mako

5.4.23 bauble.plugins.tag
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CAPITOLO 6

Appoggiare Bauble

Se utilizzi Bauble, o se ti sembra giusto aiutarne lo sviluppo, puoi considerare una donazione

39

https://pledgie.com/campaigns/29188


Bauble Documentation, Release 1.0.50

40 Capitolo 6. Appoggiare Bauble



Indice

B
bauble.db.Base (variabile built-in), 36
bauble.db.metadata (variabile built-in), 37
bauble.view.SearchView.ViewMeta (classe

built-in), 37

41


	not-so-brief list of highlights, meant to whet your appetite.
	Istallare Bauble
	Utilizzare Bauble
	Amministrazione
	Sviluppo di Bauble
	Appoggiare Bauble

